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2.

TR

FFRIR: GD32 MCUF AR

i8S : J-Link V10=GD-Link

EE &% : WIN7/WIN10 64-bit OS

IDE: eclipse-embedcpp-2021-03-R-win32-x86_64

X 4 iFEE: xpack-riscv-none-embed-gcc-10.1.0-1.1-win32-x64

g% L E: gnu-mcu-eclipse-windows-build-tools-2.12-20190422-1053-win64
GDBJR%#%: OpenOCD / J-Link GDB Server CL V7.11a
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3.

3.1.

TEFE

MR

T Eclipse, LAUCH eclipse-workspace. 7t “File->New” | AJ £ #%# # C/C++ Project, #£#%
C Managed Build.

& 3-1. HE RISC-VC T

= eclipse-workspace - Eclipse IDE

Edit Source Refactor MNavigate Search Project Run Window Help
MNew Alt+Shift+MN » | 6 Makefile Project with Existing Code
Cpen File... Il gC++ Projec-t l

[, Open Projects from File System... Project...

“ Rp F'IJ Y o g ’ Create a new C or C++ project ]
3 0
scent Files Convert to a C/C++ Autotools Project
Close Editar Ctrl+W Convert to a C/C++ Project (Adds C/C++ Natu
Close All Editors Ctrl+5hift+W | &% Source Folder
Save Ctrl+5 CS Folder
. ¢ Source File
Save As.. '—{; .
Save Al Ctrl+shiftss | (N Header File
= =
Revert | % File from Template
& Class

Maove...
Rename... F2 [3 Example..

&7 Refresh F5 | Other.
Convert Line Delimiters To 3
Print... Ctrl+P

r=  Import..

&y Export.
Properties Alt+Enter
Switch Workspace 3
Restart
Exit e = T ==Y -
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3-2. i%&$#¥ C Managed Build

= Mew C/C++ Project

Templates for Mew C/C++ Project

’ C Managed Build
\‘C':' A C Project build using the COT's managed build

»

sysfer.

g C++ Managed Build
\‘C':' A C++ Project build using the COT's managed build

CMake Project 4
A A CMalke project with a Hello World executable to get

m

sysfer.

starfed,

Empty or Existing CMake Project
A Create a CMalke project with no files. Can be used fo

create one over existing content.

|

i : | »

@

= Back MNext = Finish

fi )\ Project name, Fo B TAERM, Jy 1 7 (F @ BCK TARIE] FW H 3T o S 5L # N RISC-

V Cross GCC.

10
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3-3. $EZ RISC-V IERBMBIEETEFREE

1, Directory with specified name already exists.

Project name: Praject RISCV

[7] Use default location

-
C Project —

Location: Fh\eclipse-workspace\GD32VFL03_Firmware_Library V1.1.2\Template\Eclipse_project l Browse...

Choose file system: | default -

Praject type:

Toolchains:

> = GNU Autotools

® Empty Project
NSI C Project
Hello World Arm C Project
Helle World RISC-V C Project
ADUCM36x C/C++ Project

ello

orl

Freescale Kinetis Kbox C/C++ Project

SiFive RISC-V C/C++ Project

STM32F0ioc C/C++ Project

STM32FLxx CfC+ + Project

STM32F2xx C/C++ Project

STM32F3¢ C/C++ Project

STM32Fdxx CfC+ + Project
@ STM32F7xx CfC++ Project

> (= Shared Library

> = Static Library

> = Makefile project

¢ ® e e e e e EO®eS

Hello World Arm Cortex-M C/C++ Project
Freescale Processor Expert C/C++ Project

Arm Cross GCC
Cross GCC
MinGW GCC

| RISC.V Cross GCC

Show project types and toolchains only if they are supported on the platform

= Back ! Mext = I Finish

#Eclipse IDEC. IEf#% & T RISC-V Toolchains Path, iX HUK4x 53k #5415 . #Eclipse IDE
AW ERISC-V Toolchains Path, A 7E1X B % FIRISC-V Toolchains4a % #4% .

11



3.2.

3.2.1.

GigaDevice

ANO067
GD32 RISC-V MCU Windows %% F Eclipse JT & #f%

& 3-4. 3% RISCV X X 4%k T A4

5] |

GNU RISC-V Cross Toolchain

Toolchain name: xPack GNU RISC-V Embedded GCC (riscv-none-embed-gec)

Select the toolchain and configure path

Toolchain path:

${eclipse_homepeclipse_toolchain\xpack-riscv-none-embed-gcc-10.1.0-1.1\bin

Finish l [ Cancel

P e Bk 1 S R 3 Next ' i J5 13 °Finish”, B2 5o~ A &B-5. LA ~. &

I, SEProjectidar.

& 3-5. THEME

~ [l Includes
= Esfeclipse/eclipse toolc
(=1 Efeclipse/eclipse toolc

= eclipse-workspace - Eclipse IDE - O *
File Edit Source Refactor Mavigate Search Project Run Window Help
wi] © |® - -&| % Bi%iwl Digi-&-E-@-%-0-0-G-i®&p &~
- - - - | Q B | @ ié;
5 Project Explorer £2 = 4d =0 FFo®m % = O
=46 7 3 :
v J5 Project RISCV (in Eclipse_prc

There is no active editor
that provides an outline.

£

I=% Project RISCV

(=1 Efeclipse/eclipse_toolc

[#] Problems ] Tasks B Console %3 [ Properties =g Progress
No consoles to display at this time.

B TR RTINS

F BRI KA

A LFES, #%HFEnew->Folder,

12
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& 3-6. FELESCMHR

4[5 Proje——=——"
- MNew r [ % Project.
4 il In
X @ Go Into % Fle
=) Open in New Window “File from Template
B | shown Alteshift+w o |05 Folder
i i 2
Show in Local Terminal @ Class
B Copy Ctrl+C | [5] Header File
Paste Ctrl+V g Source File
H Delete Delete | % Source Folder
3 .
ez @ C/C++ Project
Moves Convert to a C/C++ Project (Adds CfC++ Mature]
Rename... F2
™ Example...
g Import..
= L el o B

LA A Peripherals .
3-7. B BTk

= Mew Folder

Folder

Create a new folder resource.

Enter or select the parent folder:

Project RISCV

(=)
=% Project RISCV

IFolder name: |Peripherals I

== Advanced

() = Use default location

® [ Folder is not located in the file system (Virtual Folder)

Resource Filters...

default

I_) kg Link to alternate location [Linked Folder)

Browse...

Variables...

| Finish | Cancel

[ #7514 57 Application. DocHllUtilities S 143 . H:7F Peripherals 342 P # 37 Source 1~ 34

13
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. LERISCV A3 P i 7. drivers. env_Eclipseflstubs ¥ 3143,

& 3-8. RISC-V 241 &

ra

= cclipse-workspace - Eclipse IDE

4|[=% Project RISCV (in Eclipse_project)
4 5l Includes
- (2! E:feclipse/eclipse_toolchain/xpack:
- (=) E:feclipse/eclipse_toolchain/xpack:
- (2! E:feclipse/eclipse_toolchain/xpack:
- gy Application
* oy Doc
4 27, Peripherals
* oy Source
4 73 RISCV
+ [7ry drivers
- gy env_Eclipse
+ [Fpy stubs
- gy Utilities

File Edit Source Refactor MNavigate Search Proj

i | B/~ @ Bi%ie|sia
5 Project Explorer &2 = O
BES TV 8

#idiApplication, i&#Importiki, " S A1

14



©

GigaDevice

ANOG7

GD32 RISC-V MCU Windows %% F Eclipse JT & #f%

& 3-9. HInsH

Includes

[y Doc
(z Periphe
& RISCV
[ Utilities

v = Project RISCV (in Eclipse_project)

Go Into

Open in Mew Window
Show In

Show in Lecal Terminal

Copy
Paste

Delete
Source
Mowve...

Rename...

Importifi#¥File System. 7L ARSI HHAR, 2AETHEFARA .

3-10. 3%+ Import 3Cf4

Alt+Shife+wW

Ctrl+C
Ctrl+V
Delete

F2

¥

¥

[ Project Explorer &2

e =5 Praject (in Eclipse_pra
4 5l Includes
> (= Eifeclipse/eclipst
» (£ Eifeclipsefeclipst
> (1= Eifeclipse/eclips

2m Application
> [y CW

> 2 Doc

> B Ld

> (73 Peripherals
> [2p Startup

> B Utilities

= ITMpoTt

T Te——

Select

Import resources from the local file system into an existing project.

Select an import wizard:

pe filter text

4 [= General
‘@4 Archive File

> = CfC++
> = Git

(7=, Install

“ Existing Projects into Workspace
[ File System
| Preterences

[} Projects from Folder or Archive

»

m

@ = Back

MNext =

Finish

15
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& 3-11. Import Application SC{t:3e Py Sc4

& Import [l
File system (o
Impaort resources from the local file system. L"r ..fA
From directory: |5:‘\eclip5e-wor|-c5pace\GD32VF1DB_Firmware_Library_V1.1.2\Temp|ate ‘ Browse...
(8] = Template L [ gd32vf103 libopth ~
[£] main.c
[ | = readme.txt
[ £ systick.c I -
Filter Types... Select All Deselect All
Into folder: | Praoject_RISCV/Application Browse...
Options
[J Overwrite existing resources without warning
[JcCreate top-level folder
== Advanced
Create links in workspace
Create wvirtual folders
Create link locations relative to:  PROJECT LOC w
?) = Back Mext = Cancel

3, ¥ P S A\ Peripherals. RISCV. DocAlUtilities 143

16
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& 3-12. Import Peripherals X432 3044

= Impart O *
File system —
Import resources from the local file system. L’f ,-’A
|From directory: [\GD32VF103_Firmware_Library V1.1.2\Firmware\GD32VF103_standard_peripheral | Browse...
] (= GD32VF103 standard_peripheral [1 [¢] gd32vi103.h
[£] system_gd32vf103.c
T [0 system_gaaeviioan
Filter Types... Select All Deselect All
Inta folder: | Project RISCV/Peripherals Browse...
Optians
[] Overwrite existing resources without warning
[]Create top-level folder
== Advanced

Create links in workspace
Create virtual folders

Create link locations relative to: | PROJECT LOC ~

g = Back Next = Cancel

17
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& 3-13. Import Peripheral-Source ({4 3¢ 30 {4

= Import O *
File system (] -
Import resources from the local file system. L’; .-‘A
Erom directory: |:irmware_Library_‘ﬂ.I.2\Firmware\GD32‘U'F1DE_standardeeripheral\Source vl Browse...
€] gd32vf103_adc.c ~
[£] gd32vf103 bkp.c
[£] gd32vf103_can.c
[€] gd32vf103 cre.c
[£] gd32vf103 dac.c
[£] gd32vf103_dbg.c
[€] gd32vf103_dma.c
1 [l ad32vf103 eclic.c v
Filter Types... Select All Deselect All
Into folder: | Project RISCV/Peripherals/Source I Browse...
Options

[ Overwrite existing resources without warning

[]Create top-level folder

<= Advanced

Create links in workspace
Create virtual folders

Create link locations relative to: | PROJECT LOC ~

?\ = Back Mext = Cancel

18
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& 3-14. Import RISCV-env_Eclipse ({4 3¢ 3014

= Impart O >
File system —
Import resources from the local file system. L”r .."A
From directory: | 32VF103_Firmware_Library_V1.1.2\Firmware\RISC\\env_Eclipse v| Browse...
[m] = env_Eclipse [8 entry.5
[J [ GD32VF103x4.1ds
[ 2 GD32VF103x6.1ds
(] E GD32VF103x8.ds
2 GD32VF103xB.Ids
[£] handlers.c
[ init.c
@ start.5
[£] your_printf.c
Filter Types... Select All Deselect All
llnto folder: |Project_RISCV,-’RISCV,-’env_Eclipse ] Browse...
Options
[] Overwrite existing resources without warning
[ Create top-level folder
== Advanced
Create links in workspace
Create virtual folders
Create link locations relative to: | PROJECT_LOC w
?) = Back Mext = Cancel

19
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& 3-15. Import RISCV-drivers 3 4304

L n200 func.c I
L] |gl n200 func.h

[ [ n200 timer.h

L] [ riscv bits.h

[ [€l risev_cansth

[ [€ riscv_encoding.h

= Import O x
File system (e
Import resources from the local file system. H
From directory: [AGD32VF103_Firmware_Library V1.1.2\Firmware\RISC\V\drivers Browse...
[m] (= drivers [ [€l n200 _eclic.h

Filter Types... Select All Deselect All
Into folder: | Project_RISCV/RISCV/drivers Browse...
Options

[] Overwrite existing resources without warning

[]Create top-level folder

=< Advanced

Create links in workspace
Create virtual folders

Create link locations relative to: |PROJECT LOC w

@ = Back Mext = Cancel

20
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& 3-16. Import RISCV-stubs #3230 44

= Import O >
File system —
Import resources from the local file system. [ y

|

From directory: |2e\GD32VF103_Firmware_Library V1.1.2\Firmware\RISCV\stubs v| Browse...

[m] (= stubs _exit.c
close.c
[ fstat.c
] isatty.c
[g] Iseek.c
[€] read.c
[€ sbrk.c
L1 [gl stub.h
[£] write_hex.c
[€] write.c
Filter Types... Select All Deselect All
I Into folder: ‘ Project RISCV/RISCV/stubs Browse...
Options
[] Overwrite existing resources without warning
[l Create top-level folder
== Advanced
Create links in workspace
Create virtual folders
Create link locations relative to: | PROJECT_LOC w

® = Back Mext = Cancel

21
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& 3-17. Import Doc XX 3304

= Import

File system

Import resources from the local file system.

From directory: | Ef\eclipse-workspace\GD32VF103_Firmware_Library_ V1.1.2\Ter ~ Browse...
(m] (= Template [ [g gd32vf103_libopt.h
] [€ main.c
=l readme.txt
L] [e] systick.c
L] [g] systick.h
Filter Types... Select All Deselect All

Into folder: | Project RISCV/Dioc

Browse...

Options
[] Cverwrite existing resources without warning

[JCreate top-level folder

== Advanced

J—
Create links in workspace
Create virtual folders

Create link locations relative to: | PROJECT_LOC w

?) = Back

22
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& 3-18. Import Utilities Cf4:32 3044

= Import

File system

Import resources from the local file system.

From directory: | \eclipse-workspace\GD32VF103 Firmware Library V1.1.2\Utilities

-

O

x
*;3_—|_

-

Browse...

m] (= Utilities

l @gd32ﬁ103v_eva|.c ]

LI gl gd32vf103v_eval.h

[ [€ gd32vf103v_lcd_eval.c
O [€ gd32vi103v_lcd_eval.h

Filter Types...

Select All Deselect All

Into folder: | Project RISCV/Utilities

Options

(] Overwrite existing resources without warning

[ Create top-level folder

== Advanced

Create links in workspace
Create virtual folders

Create link locations relative to: | PROJECT LOC ~

Browse...

Cancel

23
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3.2.2.

& 3-19. B% RISC-V THEME

= eclipse-workspace - Project_RISCV/Application/main.c - Eclipse IDE

File Edit Source Refactor MNavigate Search Project Run Window Help

milhg [ ®~-& -5 # 0% v S D E -8 - - G- H$-0-Q-%- &0 - |JHE v:d - F -
5 Project Explorer &2 %Y § = 0 [Emanc B
~ 2% Project_RISCV (in Eclipse_project) A 13 are permitted provided that the following conditions are met:
. - - 14
v B Inc\udas‘ ., X X 15 1. Redistributions of source code must retain the above copyright notice, this
(2 Efeclipse/eclipse_toolchain/xpack-riscv-none-embed 16 list of conditions and the following disclaimer.
@ E:feclipsefeclipse_toolchain/xpack-riscv-none-embed 17 2. Redistributions in binary form must reproduce the above copyright notice,
[ Efeclipsefeclipse_toolchain/upack-riscv-none-embed 18 this list of conditions and the following disclaimer in the documentation
M ‘p pee P 19 and/or other materials provided with the distribution.
~ (7 Application @ 3. Neither the name of the copyright holder nor the names of its contributors
@ main.c 1 may be used to endorse or promote products derived from this software witho
@ systick.c % specific prior written permission.
3
¥ [y Doc 4 THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
= readme.txt 5 AND ANY EXP 5 OR IMPLIED WARRANT » INCLUDING, BUT NOT LIMITED TO, THE IMPL
v Peripherals 6 WARRANTIES O RCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAT
& P 7 1IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,

~ [ Source
[, gd32v103_adc.c
[, gd32vf103_bkp.c
[ gd32vf103_can.c
& gd3avf103_crec
g gd32vf103_dac.c
[ gd32vf103_dbg.c
[ gd32vf103_dma.c
[ gd32vf103_eclic.c
[ gd32vf103_exmec.c
[ gd32vf103_extic
& gd32vf103 fme.c

» OR CONSEQUENTTIAL Dv S (INCLUDING, BUT

G00DS OR SERVICES; LOSS OF USE, DATA, DR
PROFITS; OR BUSINESS INTERRUPTION) HOWE CAUSED AND ON ANY THEORY OF LIABILITY|,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (IMCLUDING NEGLIGENCE OR OTHERWISE)

!
ARISING IN ANY WAY OUT OF THE USE OF THIS SOF » EVEN IF ADVISED OF THE POSSIBI
OF SUCH DAMAGE.

INDIRECT, INCIDENTAL, SP
NOT LI ED TO, PROCU

JAR

L L L L L R R RS R BRI R R R R R

@u kW ® 00

?

#include "gd32vfle3.h”
#include "gd32vf1e3v_sval.h”
#include "systick.h”
#include <stdio.h>

main function

none
g gd32vf103_fwdgt.c none
[, gd32vf103_gpic.c none

[ gd32vf103 i2c.c
[ gd32v103_pmu.c
[ gd324f103_reu.c
& gd32vf103_rtcc
[ gd32vf103 _spi.c
[ gd32vf103 _timer.c
[ gd32vf103 _usart.c
[ gd32vf103 wwdgt.c
[ system_gd32vf103.c
v G RISCY
~ (& drivers
g n200_func.c
~ [z env_Eclipse
[§ entry.S
[, handlers.c
[, init.c
[§, start.s
& your_printf.c
|5 GD32VF103xB.Ids
o stub

int main(void)

gd eval led init(LEDI);
gd_eval led_init(LEDZ);
gd_eval led_init(LED3);
gd_eval led_init(LED4);

while(1){
/* turn on ledl, turn off led4 */

[#] Problems ¥ Tasks B Console 32 [ Properties =g Progress
No consoles to display at this time.

“Refresh” 77 s\ 37 U K v 4

B _E R T B AR R T SO B 5 N R SCA (1) 75 30k, AT DA R B 3 N SO IE R SCAF N B

FETAE 5 8 571 .cproject A 24 (S04 96 N . #EEclipse IDEHT, #ili THE 4, JFik#%kRefresh, EJI

AP SO KO BN TR .

3-20. THESCHdessi
=5

settings
Firmware
Template
Utilities
| .cproject

| | .project
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K] 3-21. Refresh T2

= eclipse-workspace - Eclipse IDE

File Edit Source Refactor MNavigate Search Project Run  Wind

R TIRE SR RN R T
G Bl @D |
i Project Explorer &3 = 0
BES T &
v = gd32vi103 e :
~ [l Includes New ’
@ Ev/eclic Go Into
(= E:/eclip Open in New Window
= EB/eclE  ShowIn Alt+Shife+W >
Show in Local Terminal »
[E Copy Ctrl+C
Paste Ctrl+V
¥ Delete Delete
Source ¥
Move...
Rename... F2
fxy Import..

g Export..

Build Project
Project

Fs

Close Projert
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& 3-22. Eclipse IDE § THE45#)

i Project Explorer &3 = O
T

v =% gd32vf103_example

“ [l Includes

w = Firmware
(= GD32VF103 standard periphera
= RISCV

v (= Template
qd32vf103 libopth
[g main.c
[£] systick.c
systick.h
= readme.txt

w = Utilities
= LCD_comman
[¢ gd32vf103v eval.c
gd32vf103v_eval.h
[¢ gd32vf103v lcd eval.c
qd32vf103v _lcd_eval.h

= E:feclipse/eclipse_toolchain/xpat
= E:feclipse/eclipse_toolchain/xpat
= E:feclipse/eclipse_toolchain/xpat

(2! Problems 4] Tasks B 4
Mo consoles to display at this 1

ER: “RefreshJ7 sUE LM SCIF RSO, B ALAFAEMN, I H— HfEEclipse IDE Ml
RSO, ZSCF 2 B MRS 1.

ZN AN
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3.3.

3.3.1.

TERE

Fi TR, TR 8 M Propertiesit {7 T
& 3-23. TEREHEE

a il Incl
2 (= B
- = B
- = B

< 27 APR

= g
5@,—
5@5L

- gy CM

4 g Dod x

19 19
8 B
g
J.on =

[\ p

% %0

&

¥ TR i O TNV O ¥ O (TN Vi O ¥ O (TN Vi O O (TN ¥ O TN (TN ¥ SO TN TN ¥ WO (O U WOV O [

v BPEPEPPEFEPPEEREEPEPEERE pF

o

g -

4|5 Project (in Eclipse_project)

MNew

Go Into

Open in Mew Window
Show In

Show in Local Terminal

Copy
Paste

Delete
Source
Move...

Rename...

Import...
Export...

Build Project
Clean Project
Refresh

Close Project

Close Unrelated Project

Alt+Shift+W »
>

Ctrl+C
Ctrl+V
Delete

»

F2

F5

Build Targets

Open Properties Dialog ]
3

Index

Build Configurations

Profiling Tools
Run As

Debug As
Profile As

Restore from Local History...

Run C/C++ Code Analysis

Team
Compare With
Validate

Configure

Source

&

pos I
Util

Properties l

3

r ¥ ¥ ¥

Alt+Enter

ol ]

Target Processor it &

1E£“C/C++ Build->Settings->Tool Settings->Target Processor” FECE 411 T :

WRAE HAR S N, P Target. 7EAGIH, EHERV3I2I.
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A 3-24. RISCV Lf2 Target Processor BL &

= Properties for Project_RISCV - ~ - - L@g
type filter text Settings & >
> Resource -
Builders ) . - : 1~
4 C/C++ Build Caonfiguration: [De ug [ Active ] v] [Manage Canfigurations...

Build Variables
Environment -
cacing i Tool Settings | 53 Toolchains | [ 1 De'\.ricesl [ Container Settings | 4 Build Steps Buil * | *

' I [ Target Processor I Architecture ’RV321 (-march=rv32i*)
Tool Chain Editor

(# Optimization
# Warnings
(# Debugging . .
4 [ GNU RISC-V Cross Assembler Floating peint lNone
(2 Preprocessor [¥] Compressed extension (RVC)
(22 Includes
(2 Warnings
(& Miscellaneous Floating point ABI ’None
s - i . B 0
4 ) GNU RISC-V Cross C Compiler Tuning [Toolcham default
(2 Preprocessar i
2 Includes Code madel [Toolchain default
(2 Optimization
(2 Warnings
(8 Miscellaneous Align ’Toolchain default (-mtune)
4 3 GNU RISC-V Cross C Linker
(& General
(2 Libraries
(# Miscellaneous
4 8 GNU RISC-V Cross Create Flash Image
(2 General
4 % GNU RISC-V Cross Print Size
(2 General

» CfC++ General
Linux Tools Path
> MCU
Project Matures

Multiply extension (RVM]
[¥] Atomic extension (RVA)

Project References
Run/Debug Settings

m

Integer ABI ’ILP32 (-mabi=ilp32%)

Task Repository
Task Tags

> Validation
WikiText

Small data limit 8

[[]5mall prologue/epilogue (-msave-restore)

Force string operations to call library functighs (

Other target flags

£ [Apply and Close] ’ Cancel

——

3.3.2. Optimization fic B

7£“C/C++ Build->Settings->Tool Settings->Optimization”i% i H it & i i % 9%, 7i%-00. -O1.
-02, -03. -Os. -Ofast. -Og.
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3.3.3.

& 3-25. Optimization it B

type filter text

Resource

w CfC++ Build

|
Build Variables

1

Environment

Logging
#_Seﬂings
ool Chain Edito

C/C++ General
Linux Tools Path
MCU

Project Natures
Project References
Run/Debug Setting
Task Repository
Task Tags
Validation
WikiText

@

S Properties for Project RISCV

Settings

Configuration: | Debug [ Active ]

& Tool Settings Y Toolchains M Devices

~ | | Manage Configurations...

[0 Container Settings # Build Steps E[*

3

@ Target Processor

Warnings
(# Debugging
w % GNU RISC-V Cross Assembler
(2 Preprocessor
2 Includes
# Warnings
(2 Miscellaneous
w 5 GNU RISC-V Cross C Compiler
(%2 Preprocessor
(% Includes
(% Optimization
(% Warnings
(# Miscellaneous
w [ GNU RISC-V Cross C Linker
(& General
(% Libraries
(& Miscellaneous
v & GNU RISC-V Cross Create Flash Image
(& General
w B GMU RISC-V Cross Create Listing
(2 General
w & GMU RISC-V Cross Print Size
(2 General

Optimization Level Optimize size (-Os)

Message length (-fmessage-length=0)
[71'char' is signed (-fsigned-char)

[ Function sections (-ffunction-sections)

[] Data sections (-fdata-sections)

[ Me common unitialized (-frno-commaon)
Do not inline functions (-fno-inline-functions)
[]Assume freestanding environment (-ffreestan
[ Disable builtin (-fno-builtin

[JSingle precision constants (-fsingle-precision-
[JPosition independent code (-fPIC)
[Link-time optimizer (-flto)

[IDisable loop invariant move (-fno-move-loog

Other optimization flags

Apply and Close

Cancel

GNU RISC-V Cross Assembler it &

TE“C/C++ Build->Settings->Tool Settings->GNU RISC-V Cross Assembler”i%& 15+ fic & Cross

TG 2 PR I

ft"includes->Include paths” i I8 i1 LFEFT 75 (1) Assemblersk SCHFE& AR . 7E A H 0 -

"${ProjDirPath}/../../Firmware/RISCV/drivers"
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& 3-26. GNU RISC-V Cross C Assembler -> Includes Bt &

= 1 i - (Bl
= Properties for Projec‘t_R]SEV _— — - !- u_‘q

type filter text Settings - -~
> Resource -
Builde _ E

4 C/C++ Build Configuration: lDebug [ Active ] v] [Manage Conﬁgurations...]

Huild Variables

Environment

Loggin B Tool Settings | # Toolchains | ‘B Deuicesl [ Container Settings | # Build Stepsl S [
"
Settings

(# Target Processor
(2 Optimization
(2 Warnings

II 0ol Chain Editor
» CfC++ General

Include paths (-T) & o 8

Linux Tools Path {8 Debugging
> MCU

4 (%) GNU RISC-V Cross Assembler
Project Natures

. Preprocessor
Project References
Run/Debug Settings =

(2 Warnings

m

Task Repository (# Miscellaneous
Task Tags

- 4 %y GNU RISC-V Cross C Compiler
- Valll?iatlon ( Preprocessor Include system paths (-isystem) 8 5 &
WikiText (# Includes
(& Optimization
(# Warnings
(# Miscellaneous
| 4 %5 GNU RISC-V Cross C Linker
(# General
(# Libraries
(# Miscellaneous
4 %) GNU RISC-V Cross Create Flash Image ;
& General Include files (-include) L= EARS
4 [ GNU RISC-V Cross Print Size
(2 General

©)

[Apply and Close] [ Cancel

3.3.4. GNU RISC-V Cross C Compiler fit B

TE“C/C++ Build->Settings->Tool Settings->GNU RISC-V Cross C Compiler”i%& 5 + fic & Cross
Comri I,

A5l ,  {E “Preprocessor->Defined symbols” i 5 1 ¥ it USE_STDPERIPH_DRIVER I
GD32VF103V_EVALTi%i 1% %
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& 3-27. GNU RISC-V Cross C Compiler -> Preprocessor BC B

=

S Properties for Project_RISCV L = [C ﬂj
type filter text Settings Q- v &
+ Ry . .
Fsoures @ Target Processar [[IDo not search system directories {-r *
C/Ct+ Build | %: Optirrjization [[]Preprocess only (-E)
Build Variables (& Warnings Defined symbols (-D) £ 5 ¢

(25 Debugging

Environment

(2 Includes
(¥ Warnings

Tool Chain Editor
» C/C++ General

.
Linux Tools Path @3 Miscellaneous

McU 4 SoRILLDIC L = CComp“er
, ¥ Preprocessor
Project Natures
(2 Includes

Project References = Outimizati
. ¥ Optimizat
Run/Debug Settings & e |rrl1|za en
Task R 't (% Warnings
ask Reposito
P v & Miscellaneous

Task Tags =

1
i 4 ) GNU RISC-V Cross Assembler USE_STDPERIPH_DRIVER | 18
ooaing
@ Preprocessor

m

5 . .
. Validation 4 B8 GMNU RISC-V Cross C Linker

WikiText

(& General Undefined symbals (-U) &

(% Libraries
I (# Miscellaneous
4 B8 GMNU RISC-V Cross Create Flash Image
[l # General
4 By GNU RISC-V Cross Print Size
# General

@' [Apply and C|crse] l

Cancel

fE”includes->Include paths”i% I H 78 I LA i 5 (0 Sk ST R A . AEAR] s -
"${ProjDirPath}/../../[Firmware/RISCV/env_Eclipse"
"${ProjDirPath}/../../[Firmware/RISCV/drivers"
"${ProjDirPath}/../../[Firmware/GD32VF103_standard_peripheral/Include"
"${ProjDirPath}/../../Template"

"${ProjDirPath}/../../Utilities"

"${ProjDirPath}/../../IFirmware/RISCV/stubs"
"${ProjDirPath}/../../Firmware/GD32VF103_standard_peripheral"

R G AN S SO B AR AR X BR A . X BB AT DL EL RS INZE 0] B AT
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3.3.5.

& 3-28. GNU RISC-V Cross C Compiler -> Includes At B

‘= Properties for Project_RISCV

———— 4 T EE

type filter text

> Resource
Builders
Build Variables
Enviranment
Logging
Toal Chain Editor
» C/C++ General
Linux Tools Path
> MCU
Project Natures
Project References
Run/Debug Settings
Task Repository
Task Tags
» Validation
WikiText

Settings

-

-

§

Configuration: [Debug [ Active ]

'] [ Manage Configurations... ]

# Tool Settings | ) Toolchains | ‘H Da'vicasl 0 Container Saﬂingsl 4 Build Slepsl

Build Artifact | &) Binary| * |

(# Target Processor
(# Optimization
(& Warnings
(22 Debugging
4 B3 GNU RISC-V Cross Assembler
@ Preprocessor
(52 Includes
# Warnings
2 Miscellaneous
4 % GNU RISC-V Cross C Compiler
Preprocessor
(2 Optimization
(2 Warnings
2 Miscellaneous
4 B3 GNU RISC-V Cross C Linker
(% General
2 Libraries
% Miscellaneous
4 B3 GNU RISC-V Cross Create Flash Image
(% General
4 8 GNU RISC-V Cross Print Size

2 General

Include paths (-I)

[EEER=RE

{ProiDirPathj/. .Ut

${ProjDirPath}/../../Firmware/RISCV/drivers
"${PrajDirPath}/..[../Template”
"${PrajDirPath}/..[../Firmware/RISCV/env_Eclipse”
"${ProjDirPath}/../../Firmware/RISCV/stubs"
"${PrajDirPath}/..[../Firmware/GD32VF103_standard_peripheral”
"${ProjDirPath}/../../Firmware/GD32VF103_standard_peripheral/Include"

4 mn | v
Include system paths (-isystem) [EEAR=RRY|
Include files (-include) LER AR

-

m

®

[Apply and CIDseJ l Cancel

|

GNU RISC-V Cross C Linker fit &

7£“C/C++ Build->Settings->Tool Settings->GNU RISC-V Cross C Linker’fii & Cross Chf ik

T,

7£“General ->Script files” XL 1 s i -

"${ProjDirPath}/../../Firmware/RISCV/env_Eclipse/GD32VF103xB.Ids"

IdBAIAS A7 B T VRBES AR, G B SE BN AT SAT SCAF AT S B A7 3 I BAIAR 124 & H Bt
J1 IFLASH L SRAM K /N e %5 7 T it B A7 BC B«

R AGITH ARSI B AR B AR . X B ] DAEL AN 4 0] R A7
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& 3-29. GNU RISC-V Cross C Linker -> General fit B

= Properties for Project_RISCV S—
—

— e —

e e S 8 )

type filter text

> Resource
Build Variables
Environment
Logging
Toal Chain Editor
| C/C++ General
| Linux Tools Path
> MCU
Project Natures
Project References
Run/Debug Settings
Task Repository
Task Tags
> Validation
WikiText

Settings

Configuration: ’Debug [ Active ]

'l ’Manage Configurations... I

B Tool Settings | 53 Toolchains | ‘B Devices | 0 Container Seﬂingsl # Build Stepsl

Build Artifact | [ « |

@ Target Processor
# Optimization
# Warnings
# Debugging
4 3 GNU RISC-V Cross Assembler
(2 Preprocessar
(2 Includes
& Warnings
& Miscellaneous
4 B33 GNU RISC-V Cross C Compiler
@ Preprocessor
& Includes
& Optimization
& Warnings
(& Miscellaneous
4 133 GNU RISC-V Cross C Linker

( Miscellaneous
4 83 GNU RISC-V Cross Create Flash Image

Script files (-T)

${ProjDirPath}/../../,Firmware/RISCV/env_Eclipse/GD32VF103xB.IJ

a8 84l &

m

(2 General
4 B3 GNU RISC-V Cross Print Size
(2 General o I
[V] Do not use standard start files (-nostartfiles)
[ Do not use default libraries (-nodefaultlibs)
[T No startup or default libs (-nostdlib) A
[V] Remove unused sections (-Xlinker --gc-sections) N
|| Print removed sections (-Xlinker --print-gc-sections)
EOmit all symbol information (-s) -
® lAppIy and Close] [ Cancel ]

7EMiscellaneousi i, ‘ai%kUse newlib-nano /Do not use syscalls. CFJEALALES A /M)
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3.3.6.

K] 3-30. GNU RISC-V Cross C Linker -> Miscellaneous . B

C/C++ Build

Sulld Variables
Environment
Logging

gorenam Editor
C/C++ General
Linux Tools Path
MCU

Project Matures
Project References
Run/Debug Settings
Task Repository
Task Tags
Validation

WikiText

Configuration: | GD32VF103xB [ Active ]

& Tool Settings ) Toolchains M Devices

S Properties for Project RISCV O X
pe filter text x Settings e v 8
Resource ~
Builders

~| | Manage Configurations...

[0 Container Settings # Build Steps E ¢

(2 Target Processar
# Optimization
(# Warnings
# Debugging
~ B3 GNU RISC-V Cross Assembler
(22 Preprocessor
22 Includes
(2 Warnings
(2 Miscellaneous
~ B3 GNU RISC-V Cross C Compiler
(22 Preprocessor
22 Includes
(# Optimization
(2 Warnings
(2 Miscellaneous
~ [ GNU RISC-V Cross C Linker
# General
o .

(£ Miscellaneous

~ 3 GNU RISC-V Cross Create Flash Image
(# General

~ 8 GNU RISC-V Cross Create Listing
# General

~ & GMNU RISC-V Cross Print Size
# General

Linker flags (-Xlinker [option]) &

Other objects &

Generate map "${BuildArtifactFileBaseName

[ Cross reference (-Xlinker --cref)

[1Print link map (-Xlinker --print-map)

Use newlib-nano (--specs=nano.specs) I
L[Use float with nano prﬁl L-u _printt_floa

[JUse float with nano scanf (-u _scanf float)

Do not use syscalls (--specs=nosys.specs) l

L Verbose (-v)

Other linker flags |

Apply and Close

Cancel

Build Steps At & -4 5% bin 304

7£“C/C++ Build->Settings-> Build Steps” a4, A= pibin/hex3C 1.

A fFoFws riscv-none-embed-objcopy -O binary "Project_RISCV.elf"
"Project_RISCV.bin"; riscv-none-embed-objdump  -D  "Project_RISCV.elf" >

"Project_RISCV.dump"
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3.4.

& 3-31. Build Steps IL &

S Properties for Project RISCV

Resource
Builders ) -
v C/C++ Build Configuration: |GD32VF103xB [ Active ]

Build Variables
Environment

Logging

ool Chain Editor

C/C++ General

Pre-build steps

Command:

| Manage Configurations...

% Tool Settings & Toolchains B Devices [ Container Setting . Build Steps Build Artifact Binary Parsers @ Error Parsers

Linux Toals Path “

mMCcU
Project Natures [

Description:

Praject References

Run/Debug Settings Postbuild steps

Apply and Close

Task Repository ommand:
Talszrags [eov-none-embed-objcopy -0 binary "Project RISCVeIF_*Project RISCV.bin® iscv-none-embed-objdump -D “Project RISCV.elT » “Project RISCVdump | <]
Validation

WikiText Description:

3]

@

Cancel

kLR

1k F&Project->Build Project 7] 4 % 24 i THE.

Ny

R Build Project/Z 4% 2451 L, Build All/Z %1% 24 iiworkspace i Li%.

3-32. Build T2

= eclipse-workspace - Eclipse IDE

File Edit
9 -

Source Refactor Mavigate Search | Project Run

| B~/ - @ & D %
BES Y § = 0

Window Help
Open Project

it Project Explorer &2 Az=Eho e

=% Project_ RISCV (in Eclipse_project) [zé  Build All Ctrl+B
Build Configurations »
Build Project 5 Project
Build Working Set »
Clean...

Build Automatically

Build Targets »
C/C++ Index »
Properties

HER: BRI AT S R A0 TAE N 1, g 02 £ — kI TR . 22U, 08 T iR

TE#h,35 5clean T.52 5 Fbuild .

miEseRE, B EA T M felf. hex & bin3Cf4.

35




ANOG7

GigaDevice GD32 RISC-V MCU Windows % 4: I~ Eclipse 7 & #if:

3-33. Build RISC-V Ti25em

I$ eclipse-workspace - Project_RISCV/Application/main.c - Eclipse IDE

:@ﬂ

File Edit Source Refactor MNavigate Search Project Run Window Help
i &2 |8 ~-R -G B % |- &~ -@ - -0 Q- ®E 4
Brf-overo-m
5 Proje.. 83 = 8 main.c &2 =
B%Y §
) L Protect (in Edlipse | 22
S Project (in Eclipse. 35 ginclude "gd32vfies.h”
4% Project RISCV (in| 37 #include “"gd32vf1@3v_eval.h”
’?,‘f Binaries 38 #include "systick.h”
. 39 #include <stdic.h>
> 1 Includes 40
> i Application 418 /*!
> = Debug 42 main function
D 43 [in] none
> Doc LE) [eut] none
> (¢ Peripherals 45 none
> G RISCV s
6o int main(void)
> 2 Utilities I
* enable the LED clock */
rcu_periph_clock enable(RCU GPIOC);
1 rcu_periph_clock_enable(RCU_GPIOE);
2 '* configure LED GPIO port */
3 gpio_init(GPIOC, GPIO_MODE_OUT PP, GPIO_OSPEED_S@MHZ, GPIO PIN @ | GPIO.
4 gpio_init(GPIOE, GPIO_MODE_OUT_PP, GPIO_QSPEED S@MHZ, GPIO_PIN @ | GPIO
5
gpio_bit_reset(GPIOC, GPIO_PIN_@ | GPIO_PIN_2);
gpio bit reset({GPIOE, GPIO PIN @ | GPIO PIN 1);
L PR
4 | m
[ Problems 4 Tasks B Console &2 [ Properties X | LU T
CDT Build Console [Project_RISCV]
./Peripherals/system_gd32vfl@3.0 ./Application/main.o ./Application/systick.o
Finished building target: Project_RISCV.elf
make --no-print-directory post-build
riscv-none-embed-cbjcopy -0 binary “"Project_RISCV.elf" “Project_RISCV.bin"; riscv-none-embed-cbjdump -D
"Project_RISCV.elf" » "Project RISCV.dump"
Invoking: GNU RISC-V Cross Create Flash Image
riscv-none-embed-cbjcopy -0 ihex "Project_RISCV.elf"™ "“Project_RISCV.hex"
Finished building: Project RISCV.hex
Invoking: GNU RISC-V Cross Print Size
riscv-none-embed-size --format=berkeley "Project_RISCV.elf"
text data bss dec hex filename
2872 112 2198 5182 143e Project RISCV.elf
Finished building: Project RISCV.siz
19:13:53 Build Finished. @ errors, @ warnings. (tock 25.975ms)
« [ »
Writabhle mart Tncert 24 80 11

- 1

Q ® @
B FFox ™ = B8
c P EEBERY X

oon &

= gd3avi103.h

o gd32vf103v_evalh
U systickh

o stdioh

@ mainfvoid) : int

m,

.

3.5. fEF J-Link T8 AFRTRE

3.5.1. Debug it & 7 1H

e, A diRun->Debug Configurations, i ADebugffit & 5 i .
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A 3-34. #t \ Debug Configurations 51

= eclipse-workspace - Project RISCV/Application/main.c - Eclipse IDE
File Edit Source Refactor Mavigate Search Project Run Window Help
- | o ‘%. v o | u @ > &% - € Qj Run Last Launched Ctrl+F11
] - - 1 F o - - | i 3% Debug Last Launched F11
I Project Explorer &2 = 8  |g mainc 52 - Profile Last Launched
=R W/ Profile History *
M = Project RISCV (in Eclipse_project) ; S Profile As >
[l Includes 4 Profile Configurations...
6 VErsS Run Hist ¥
= Debug 5, un History
Gy Doc 5 ) RunAs >
G Peripherals 9= / Run Configurations...
1a Copyr
i RISCV 11 Debug History >
] Utilities 12 Redis; # Ehun Ao b3
13 are permi -
14 Debug Configurations...
15 1. Rel :
16 1i. Breakpoint Types >
17 2. Res . o
18 th Toggle Breakpoint Ctrl+Shift+B
13 an Toggle Line Breakpoint
28 3. Nel -
Zl ﬂ.: Toggle Watchpoint
22 spy Toggle Methaod Breakpoint
ii ThIS | ® Skip All Breakpoints Ctrl+Alt+B
& 4
25 AND ANY E! Remave All Breakpoints
26 WARRANTIE:
27 1In ne evel @y  External Tools >

i FJ-Link GDBServerCL{E NGDB Server, ffHGCCI. H##+ IGDB I EA{F NGDB Client.

M diGDB SEGGER J-Link Debugging, i —2J-Link i fic & & 1 .

3.5.2. Main E&3E
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3.5.3.

& 3-35. GDB SEGGER J-Link Debugging-Main %%+

= Debug Configurations —
Create, manage, and run configurations
¥ = X | S Name: Project_RISCV Debug
type filter text [l Main| %% Debugger| B Startup| %~ Source | [C] Common | 7, SVD Path

[E] ¢/C++ Application Bz
[E] ¢/C++ Attach to Application

[€] C/C++ Container Launcher Project RISCY
[£] C/C++ Postmortem Debugger C/C++ Application:
[E] C/C++ Remote Application
Cif C/C++ Unit

Debug\Project_RISCV.elf

[£] GDB Hardware Debugging Variables... ] ’Search Projed...] i Browse... ]
[€] GDB OpenQCD Debugging Build (if required) before launching

[£] GDB PyOCD Debugging

[£] GDB QEMU Debugging Build Configuration: | Select Automatically v]

4 [c]| GDB SEGGER J-Link Debugging

(71 Enable auto build (") Disable auto build
[ iReciecHRISCVIDEhay @ Use workspace settings Configure Warkspace Settings...
[€] Project Debug
& Launch Group
q |~ n ¢
Filter matched 14 of 15 items e e
'i?:' [ Debug l ’ Close ]

EMainiE R, EFUET TR, — RS HRINYEr TR Fielf o WiREs, bl bl
Browse, Fahisinelf ot

R WRZHTHPE T 2GS, B EER B AT RAT SO elfe 9 77 E, ] UK AR
ST i —EDebugf L & .

Debugger E3-E

7EDebuggeri& ik, 5 H x5 Device name, A+ HGD32VF103VBT6.

e Eclipse M E R O IE A AC B J-Link 642, X BB B3R . iR BT E IEMRECE,
A {EExecutable pathf, %+ J-Link GDBServerCL [ 45T #5545 .

Commandst i 5 :
set mem inaccessible-by-default off

set arch riscv:rv32

ER: JSHGHAS, ERTRCE M J-Link 3K A BUCR . WRASCRF, 17+ 2J-Link Sk SR
N
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3.5.4.

& 3-36. GDB SEGGER J-Link Debugging-Debugger %5

= Debug Conﬂgurations-

il

Create, and run

il =

CEPREX BT~

x

[T] C/C++ Application
[E] C/C++ Attach to Application
[E] C/C++ Container Launcher
[E] C/C++ Postmortem Debugg
[E] C/C++ Remote Application
Cif C/C++ Unit
[t] GDB Hardware Debugging
[t] GDB OpenOCD Debugging
[©] GDB PyOCD Debugging
GDB QEMU Debugging
4[] GDB SEGGER J-Link Debugg
[©] Project RISCV Debug
[] Project Debug
i Launch Group

4 T 3

Filter matched 14 of 15 items

Name: Project RISCV Debug

Main | %5 Debugger] [ 3 Starlup| Hp Source| i=| Common| 2, sVD Palh|

J-Link GDB Server Setup
Start the J-Link GDB server locally

["] Connect to running target
w—

Executable path:  ${jlink_path}/${jlink_gdbserver}

Actual executable: D:\Program Files\SEGGER\JLink/JLinkGDBServerCL.exe

Endianness: Little ) Big

Connection: @ USB oI

Interface: ) SWD

Initial speed: ) Auto () Adaptive @ Fixed 1000  kHz

GDB port: 2331

SWO port: 2332

Telnet port: 2333 Local host only
Log file:

Other options: -singlerun -strict -timeout 0 -nogui
Allocate console for the GDB server

GDB Client Setu

Executable name:  ${cross_prefixjgdb$icross_suffix}

Actual executable:

riscv-none-embed-gdb

Other options:

Commands: set mem inaccessible-by-default off

set arch risowirv32

Browse... | | Variable

to change it use the alobal or workspace preferences pages or the project properties p¢
Device name: GD32VF103VBTG u

Supported device na

[ silent

(USB serial or IP name/address)

[¥] Verify downloads [/ Initialize registers on si

[¥] Allocate console for semihosting and SWO

Brows

Variable

»

m

Revert

Apply

@

Debug

J

Close

Startup LIk

7EStartupi ik HH AL & -
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3.5.5.

3.6.

3.6.1.

& 3-37. GDB SEGGER J-Link Debugging-Startup i£5i-&

-
= Debug Configurations

ERCEER IN=Ia
type filter text
[E] ¢/C++ Application
[E] C/C++ Attach to Applicati
[E] C/C++ Container Launche
[E] C/C++ Postmortem Debu
[E] C/C++ Remote Applicatic
Cif C/C++ Unit
[£] GDB Hardware Debuggin
[£] GDB OpenOCD Debuggir
[E] GDB PyOCD Debugging
[£] GDB QEMU Debugging
4 [c] GDB SEGGER J-Link Debu
[€] Project RISCV Debug
[] Project Debug
@ Launch Group
] 1 ;

Filter matched 14 of 15 items

@

oy

Create, manage, and run configurations

MName: Project_RISCV Debug

[El Main | %% Debugger | B+ Startup | & Source | [C] Common

[CTRAINT aPPTICEUOIT [TeIvau diver U TesETesEntg

Run/Restart Commands

., SVD Path

[] Pre-run/Restart reset I Type: 1

lalways executed at Restart)

[[5et program counter at (hex):
[¥] Set breakpoint at:
Caontinue

main

m

Restore de

I

3

[ Reen ][ ek

[ Debug |[ Close |

SVD Path &I+

#ESVD Pathik i, e+ H AR 7 i f iISVD LAt .

& 3-38. GDB SEGGER J-Link Debugging-SVD Path %%+

S Debug Configurations

Create, manage, and run configurations

FeRX BT

Name: ‘ProjectﬁRlSCV GD32VF103xB

type filter text

[E] C/C++ Postmortem Debugger
[E] C/C++ Remote Application
Cif C/C++ Unit
€ GDB General Debugging
[£] GDB Hardware Debugging
[t] GDB OpenOCD Debugging
[E] GDB PyOCD Debugging
[£] GDB QEMU Debugging

v [c] GDB SEGGER J-Link Debugging

[©] Project RISCV

@ Launch Group

Filter matched 14 of 31 items

=3
@

~

| [2) Main | %5 Debugger | b= Startup | B~ Source | T Commnl ', SVD Path I

SVD file (used by the peripheral registers viewer, may be _svd.zip]

File path: |Ex\eclipse-workspace\GD32VF103 Firmware Library V1.1.2\GD32VF103.svd | | Browse... |I Variables...

Revert Apply

Debug Close

£ GD-Link FH & IFRTE

Debug Bt & 7 H
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ESEHRA T, S diRun->Debug Configurations, #f ADebugfit & 7 .

&| 3-39. Bt A Debug Configurations 51

= eclipse-workspace - Project_RISCV/Application/main.c - Eclipse IDE
Fle Edit Source Refactor Mavigate Search Project Run Window Help
- | B - % AT | u B~ af v [c QJ Run Last Launched Ctrl+F11
- - i b o - | a 3, Debug Last Launched F11
I Project Explorer £2 = 8  [d mainc & B Profile Last Launched
il P
2% 7 8 1 /x Profile Histary )
W iz Praject RISCV (in Eclipse_project) ; o Profile As >
[ Includes 4 Profile Configurations...
e, Application; 5 =
= Debug -
G Doc z ) RunAs ¥
5, Peripherals 9=/ Run Configurations...
18 Copyr
i RISCV 11 Debug Histo >
9 Yy
[ Utilities —2 REdi-T’- +5 Debug Ao +
13 are permi] B
14 Debug Configurations...
15 1. Rel :
16 14 Breakpoint Types >
17 2. Rex . -
18 th. Toggle Breakpoint Ctrl+Shift+B
13 an Toggle Line Breakpoint
28 3. Nej - .
21 mal Toggle Watchpoint
22 sp Toggle Method Breakpoint
23 - -
24 THIS | & Skip All Breakpoints Ctrl+Alt+B
25 AND ANY E: Remove All Breakpoints
26 WARRANTIE!
27 1N No Evel @y  External Tools »

f# FHOpenOCD1E NGDB Server, {#fGCC L 4+ ()GDB L EAF AGDB Client. M diGDB
OpenOCD Debugging, #&—%20penOCD R & % i .

3.6.2. Main E&3E
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3.6.3.

& 3-40. GDB OpenOCD Debugging-Main &5+

= Debug Configurations O *

Create, manage, and run configurations

[#f s = *| B Y - Name: |Projer:t_R|SCV Debug |

type filter text | 2] Main| %¥ Debugger| B+ Startup | - Source | [C] Comman| &, SVD Path
[E] C/C++ Application
[€] C/C++ Attach to Application
[€] C/C++ Container Launcher |Project_RISCV Browse..
[E] C/C++ Postmortem Debugger 11 C/C++ Application:
[£] C/C++ Remote Application
Cif C/C++ Unit

Project:

| Debug\Project RISCV

& GDB General Debugging Variables... Search Project... Browse...
[c] GDB Hardware Debugging Build (if required) before launching
w [c| GDB OpenOCD Debugging
[£] Project RISCV Debug Build Configuration: | Select Automatically w
[c] GDB PyOCD Debugging (D Enable auto build (O Disable auto build
[£] GDB QEMU Debugging (® Use workspace settings Configure Workspace Settings...
[€] GDB SEGGER J-Link Debugginc
& Launch Group
£ >
Revert Apply

Filter matched 14 of 14 items

EMainiE K, EFUET LR, —RE HR NS ar LR el scfF. WiREs, bl bl
Browse, Fahisinelf it

R WRZATHPE T 2GS, FEEER B AT HRAT SO elf e Dy 758, R DA AR
ST i —EDebugf L & .

Debugger E3-E

FEFA E Eclipse R 15 O IE#FC B OpenOCD 4%, ix Bl [ #h1H5. tn 2w kA LA E
1] 7EExecutable path#%, %"+ OpenOCD[14ax} 1%

fEConfig optionst=H, IHEAHH (cfg . A+ A

-f ${eclipse_home}\eclipse_toolchain\OpenOCD\scripts\target\openocd_gdlink_gd32vf103.c
fg

OpenOCDicfg 24t T PR 2% R P, HARES F iR 3 J H ARt BB 5 ki 5 E B
fEFCommandst:id, 5.

set arch riscv:rv32
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3.6.4.

& 3-41. GDB OpenOCD Debugging-Debugger £

= Debug Configurations

[m] B
Create, manage, and run configurations
CReExX BY- Name: [Project RISCV Debug
type filter text | | Main | %% Debugger | B+ Startup | 5 Source | [] Common| 7., SVD Path
[E] C/C++ Application OpenOCD Setup ®
[E] C/C++ Attach to Application Start OpenOCD locally
[E] C/C++ Container Launcher 3 i 5 ‘$ yE—y " o z T
t ith: it} it
[5] C/C++ Postmortem Debugge wecutable pa {openocd_path}/${openocd_executable} rowse. ariables.
[E] €/C++ Remote Application Actual executable: ‘E:\eclipse\\ec\ipse_toolchain\OpenOCD\bin/openocd.exe
C‘,ﬁ C/C++ Unit (to change it use the global or workspace preferences pages or the project properties page)
GDB General Debugging
GDB port:
[E] GDB Hardware Debugging =
~ [t] GDB OpenOCD Debugging Telnet port:
[c] Project_RISCV Debug Td port: 6666
[E] GDB PyOCD Debugging -
[£] GDB QEMU Debugging ICU"‘r‘Q options: -f ${ec|ipse_hUme}\ec\ipse_toulchain\OpEnOCD\scripts\target\upenucd_gdlink_gdSZvﬂDS.ng
[c] GDB SEGGER J-Link Debuggi
@ Launch Group
Allocate console for OpenOCD Allocate console for the telnet connection
GDB Client Setup
Start GDB session
Executable name: ‘${cmssipreﬂx}gdbﬂcmssisufﬂx} Browse... |Variables...
Actual executable: ‘risw-nune-embed-gdb |
Other options: ‘ |
Commands: set mem inaccessible-by-default off
set arch riscvirv32
v
< >
Revert Appl
Filter matched 14 of 14 items sve EEY
SVD Path JETF
N \ — e == N
fESVD PathifiiF, &+ Hbml )i Bl f1SVDIC .
- . Y
3-42. GDB OpenOCD Debugging-SVD Path i&Ji £
S Debug Configurations O X

Create, manage, and run configurations

O E® :szEFv

Name: ‘Project_RlSCV GD32VF103xB

type filter text

| [ Main | %% Debugger | b+ Startup | i Source | [0 Commap Z SVD Path

[E] C/C++ Postmortem Debugger " SWD file (used by the peripheral registers viewer may be .svd.zip]

[c] C/C++ Remote Application

Cif C/C++ Unit

@ GDB General Debugging
[&] GDB Hardware Debugging
[£] GDB OpenOCD Debugging
[t] GDB PyOCD Debugging
[5] GDE QEMU Debugging
v [£] GDB SEGGER J-Link Debugging
[t] Project RISCV
R Launch Group

Filter matched 14 of 31 items

@

Revert

Debug

Apply

Close
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3.7. Debug F-H

Debug Configurationstit & 5¢ %5, sidiDebug, i ADebugti&l.

] 3-43. 3# A Debug -1

= Debug Configurations O X

Create, manage, and run configurations

[ B2 B X B Y Name: |Project RISCV Debug |
type filter text Main | %5 Debugger | B Startup | B Source| [ Common| &, SVD Path
[c] C/C++ Application Initialization Commands "

[c] C/C++ Attach to Apr Initial Reset. Type:

[E] C/C++ Container Lal
[E] C/C++ Postmortem |
[E] C/C++ Remote Appl
Cif C/C++ Unit
@ GDB General Debug Enable Arm semihosting
[€] GDB Hardware Deb

~ [E] GDB Open0OCD Deb Load Symbols and Executable

[5] Project RISCV Det Load symbols

[€] GDB PyOCD Debugg ®) Use project binary:

[£] GDB QEMU Debugg (O Use file: Workspace... | | File System...
[t] GDB SEGGER J-Link |

i Launch Group EymholtofiSeribes: I:I

Rl nad executahle ot

4

1 Revert Apply
Filter matched 14 of 14 item o B

Yl ZDebugt K .

& 3-44. 7# N\ Debug f1L&-2
[ = Confirm Perspective Switch @

This kind of launch is configured to open the Debug perspective when it
suspends,

This Debug perspective supports application debugging by providing views
for displaying the debug stack, variables and breakpoints.

Switch to this perspective?

[T Remember my decision

Switch Mo
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& 3-45. Debug &

S edipse-workspace - Project RISCV/Applicationfmain.c - Eclipse IDE - O x
File Edit Source Refactor NMavigate Search Project Run Window Help
il = @ #0i% - 0- Q- @5 ¥ 8% | Ez. e | & &
b -l G- Q e B
&4 Project.. 22 = O i >, = B8
L o foebw B %P5 e |
& —]
B S T 8 | 5 project RISCV Debug (1) [GDE SEGGER J-Link Debugging]
v % Project RISCV (in Ecli =
. = v 2 GD32VF103xB.elf i ) |
&l Includes .
o v f# Thread #1 57005 (Suspended : Breakpoint) 8
~ g Application — . R “
R = main() at main.c:49 0x8000894 MName Ty
& ma:;‘l.cc p JLinkGDBServerCL.exe
% sbys eee w riscv-none-embed-gdb
w
& De UQI . s Semihosting and SWWV
(= Application
(= Peripherals = GD32VF103xB.lds [T 0x0 [€] write.c ] write_hex.c (€] main.c &2
&= RISCV 26 */ .
(= Utilities =int main(void)
& makefile i i
K gd_eval led init(LEDL);
L& objects.mk gd_eval led init(LEDZ):
| & sources.mk gd_eval_led_init(LED3);
@ Doc gd_eval_led_init(LED4); < N
v &g Peripherals while(1){
(p Source /* turn on ledl, turn off ledd4 */ g
£ d3ovf gd_eval_led_on(LEDL); =]
(& system g gd eval led off(LEDA); H
fm RISCV delay_ ims(l@ee); w
Utiliti 1% tirn an Tadd  touen off ladi */
[z Utlities a 5
& console 22 @ Error Log @ Problems 3 Executables [} Debugger Console =80 mr * =0
] AN ET = e = I AR AT R |2t
Project RISCV Debug (1) [GDB SEGGER J-Link Debugging] = | o
Terminal T/0 port: 2333 A == "0
Accept remote connection: localhost only g
Generate logfile: off n
verify download: on R B G New .
Init regs on start: on ¢ 0 Memaory My
Silent mode: off
Single run mode: on Select rend¢
Target coll'mection timeouti @ ms Floating Po
———T——J—Lmklrelated settings------ Traditional
J-Link Hest interface: UsE H
J-Link script: none X
J-Link settings file: none AISC"
————— Target related settings------ Signed Inte
Target device: GD32VF1@3VETE Unsigned |
Target interface: ITAG Hex Intege
Target interface speed: leaakHz
Target endian: little v
< > < > < >
LI

3.7.1. TERA4H

op : resume&igizfT

: suspend#{Z

_J} terminateil 4

el

=l: stepinto
u:v

: step over
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3.7.2.

== step out
e
. reset

Registers &

TSRS, HEFEWindow->Show view->Registersi I, 7RI Al 2 & i Fl 25 77 25 O 1H

& 3-46. 3T Registers & M

-
5 Project Expl...
S-S
v % Project_RISCV (in Eclips
[} Includes
~ fipy Application
6y main.c
[ systick.c
~ (= Debug
(= Application
(= Peripherals
= RISCV
(= Utilities
| & makefile
| & objects.mk
| & sources.mk
v [ Doc
|5 readme.ixt
~ (& Peripherals
¥ (7 Source
[ gd32vf103_adc
[ gd32vf103_bky
[ gd32vf103_can
[ gd32vf103 cre.

% Debug

OB W R & 00

[rag

P R YR VY R FY R NT RN RV R VYR IV RN YR PV YR S ¥

=@

] 0x0 it ma

INDIRECT, INCIDENTAL, %

= edipse-workspace - Project RISCV/Application/main.c - Eclipse IDE

File Edit Source Refactor Navigate Search Project Ruelp
& #0:% -0 -Q-®p & -
@wo= 0

New Window ]

Editor >

Appearance

NOT LIMITED TO, PROCUR

- - Show View %
PROFITS; OR BUSINESS I
WHETHER IN CONTRACT, 5T Perspective > B
ARISING IN ANY WAY OUT . . #{r
OF SUCH DAMAGE. Navigation »
Preferences &
#include "gd32vfles.h” .
#include "gd32vfle3v_eval.h” =
#include "systick.h” [x]
#include <stdio.h> 6
J*! &

& Console 32 @ Error Log g Problems {3 Executables a

Project_RISCV Debug (1) [GDB SEGGER J-Link Debugging] o

SEGGER J-Link GDB Server V7.1la (beta) Command Line

o

L]

JLinkARM.d11 V7.11a (DLL compiled Apr 2@ 2021 18:18 [

Command line: -if jtag -device GD32VF1@3VBT6 -endia =

GDEIn
GDE 5
SWO r

GDB Server start settings

it file:
erver Listening port:
aw output listening port:

none
2331 -
2332 Y

I 1010 :;:;:;:‘

I e S e 3

NSEQUENTIAL DAMAGES (INCLUDING, BUT

Breakpoints
Console

Debug
Debugger Console
Debug Sources
Disassembly
Error Log
Executables
Expressions
Memeory
Memory Browser
Modules

Outline
Peripherals
Prablems

Progress

S A

Alt+Shift+Q, B
Ale+Shift+Q, C

Alt+Shift+Q, L

Alt+shift+Q, O

Alt+Shift+Q, X

Signals
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& 3-47. Registers & M

i1l Registers &3 — | O

Mame Value Des

a4 5% General Registe Gen
i zero 1]
1l ra 0xB000220 =_start0...
i sp (20008000 (Hex)
i gp 020000860
i tp OO
il t0 236870912
fid tl 0
i 12 ]
tii fp OO
il sl

titi al
i al
i a2
tiei a3
1 ad
il a5
a5
i 1 al

oo R o O o O

L
=

1

i

fini =2
0 =3
i sd
i 55
il =6
nl s7
il =8
i =9
i =10
I s11

o QR e R e Y Y o o e Y e N Y e |

3.7.3. Peripherals & 0

TESEEES, 1 FEWindow->Show view->Peripheralsit i, 7T B 0] 5 F b3 27 77 2% 118 -
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& 3-48. ITJF Peripherals &0

= eclipse-workspace - Project_ RISCV/Application/main.c - Eclip
File Edit Source Refactor Mavigate Search Project Ru el
g ] P
[mif =2 | & % @i% -0 - -®5 & - New Window S S SR
5 = i >
5 Project Expl... &2 O Debu [T]ox0 ma Ediicy
il P L,
B % 7 8§ 28 INDIRECT, INCIDENTAL, S CppEEEnER NSEQUENTIAL DAMAGES (INCLUDING, BUT
v % Project RISCV (in Eclips & 52 EEI&?SIIT:E ;E;IEEEEUE':I Show View >|°o Breakpoints Alt+Shift+Q, B
i) ur 3 U jl=
[} Includes 31 WHETHER IN CONTRACT, ST Perspective > B Console Alt+Shift+Q, C
v G Application 32 ARISING IN ANY WAY OUT o Bt
P 33 OF SUCH DAMAGE. Navigation > % Debug
: 34 */ G} Debugger Console
[ systick.c 35 Preferences £ Debug Sources
~ (= Debug 36 #include "gd32vf1e3.h"| .
= Application 37 #include "gd32vflesv_eval.h” Disassembly
- heral 38 #include "systick.h” @ Error Log Alt+shift+Q, L
(= Peripherals 39 #include <stdio.h> -
= RISCY 40 0 Executables
(= Utilities 2l Vit € Expressions
| & makefile 0 Memory
[ & objects.mk B Console %2 @ Error Log H. Problems (3 Executables @ Memory Browser
| & sources.mk B, Modules
v @y Doc Project_RISCV Debug (1) [GDB SEGGER J-Link Debugging] %= Qutline Alt+Shift+Q O
5 readme.d SEGGER J-Link GDB Server V7.1la (beta) Command Lin =3 Pen_'pherals —
v @ Peripherals JLinkARM.d11 V7.11a (DLL compiled Apr 2@ 2021 1@:16 Problems Ale+Shife+Q, X
“ [ Source
[& gd32vf103_adc Command line: -if jtag -device GD32VF1@3VBT6 -endia N bEEess
[ gd3afloably - GIDB %er‘ver‘ start settings----- f5  Project Explorer
Ly - GDBInit file: none M0 Registers
[¢) gd32vf103_can  GDB Server Listening port: 2331 o Y
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3.7.4.

& 3-49. Peripherals &0

()= Variables g Breakpoints €7 Expressions B4 Modules % Peripherals 22 g
Peripheral Address Description -
[[] 5, ENET_PTP 0x40028700  Ethernet: Precision time protocol
[ &, EXMC (xA0000000  External memory contraller
[ &, EXTI (40010400  External interrupt/event controller
[ 2, FMC 0x40022000  FMC =
[ %, PWDGT 0x40003000  Free watchdog timer
T, GPIOA 0x40010800  General-purpose 1/Os
[, GPIOB x40010C00  General-purpose 1/Os
[, GPIOC Ox40011000
[l %._ GPIOD Ox40011400
[l %._ GPIOE 0=40011800
[l %._ GPIOF Ox40011C00
= 8 ~snrmue M ANAA 3NN i
Mo details to display for the current selection.
le 0 Memory &3 I TP ="|| Ul g~ § = 8
L GPIOA: 0x40010800 22 | 9 New Renderings..
Register Address Value it
a %_ GPIOA Ox40010800
a0 CTLO 040010800 0x00000000
2 MDo [L:0] 0x0
& cTLo [3:2] 0x0
2 MD1 [5:4] x0
8 T [7:6] 0x0
8 MD2 [9:8] 0x0
£ cTz2 [11:10] x0 i
2 MD3 [13:12] 0x0 r
8 T3 [15:14] 0x0
8 MDa [17:16] 0x0
8 cTLa [19:18] Ox0
2 MD5 [21:20] )
8 CcTLs [23:22] 0x0
2 MD6 [25:24] 0x0
2 CT6 [27:26] 0x0
8 MD7 [29:28] 0x0 ~
e cT7 [31:30] 0x0
L1 CTL Dx40010804 000000000
. e ISTAT 0x40010808 0x00000000
Memory & X

FESEHEL, % “Window->Show View->Memory”, fidiMemory s [ 75+ 5, aJ LLTIF

Xt [ty Memoryi it o
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GigaDevice
& 3-50. T Memory & O
n fWindow | Help
1 Mew Window Q- 5~ 2 v
Editor 3
k = .
Appearance 8 0=Variab.. 9 Break.. @ Expre..
i [ » | ¥ Breakpoints Alt+shift+Q, B
Perspective # | E Console Alt+Shift+Q, C
d :
¥ Mavigation k P
G} Debugger Console
Preferences £ | Debug Sources
=25 [Disassembly
&1 Error Log Alk+Shift+Q, L
i) Executables
" Expressions
0 Memory
Memory Browser
h bArndnles
& 3-51. Memory & M
E Console [* Problems (2 Executables B} Debugger Console [0 Memory 2
Monitors & ¥ |0x40022010 : 0x40022010 <Hex= &2 ]-4} New Renderings...
@ 010022010 Address 0-3 4-7 B-B C-F
40022010 00000000 00000000  FCFFFFO3
40022020  FFFFFFFF 00000000 00000000 00000000
40022030 00000000 00000000 00000000 00000000
40022040 00000000 00000000 00000000 00000000
40022050 30000000 00000000 00000000 00000000
AN AN (RTATA AT TA TN (aTATA AT T IR TATA ATt A Ta T} (TR TR T AT T
3.7.5. Expressions &

TESCEARS, P “Window->Show View->Expressions”, siiiExpressions I “+"5, A L)
N TINFN A A B AR =
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& 3-52. ITJHF Expressions & H
Rurd | Window |JHelp
lﬁf|i‘= MNew Window Q-&5 4 'Tl‘}uv‘ifi"vl
Editor r
Appearance * | © B | ®-varables 9 Breakpoints 7' E
FLink: |:1l Show View l b | @ Breakpoints Alt+Shift+Q, B
Perspective » | Bl Console Alt+Shift+Q, C
nded :
ke Mavigation r # | Debug
¥ ' ! Debugger Conscle
=() at Preferences B Debug Sources
£:71 Oxsoooesg | bl
000426 == Disassembly
&1 Error Log Alt+Shift+Q, L
' >
[ systickc 52 ™ F’“ Expressions I
0 Memory
@ Memory Browser
& 3-53. Expressions & O
(*)= Variables ®g Breakpointd Y Expressions 2§ Modules = O
P X% It E
Expression Type Value
)= delay volatile uint32_t 993
b Add new expressio
R : Ecplise A A EAUH 1 1EIE4T IRPIRAS N A4 ) LA A AL B, 27 I8 53k S 58548 1 AA
3.7.6. RICHE 1

1EIER T B A% FEInstruction Stepping Modei% 4, TSI & .

K 3-54. T RICgRE O

=~ & %o e B S0 Q-

FERICHRE 1, Al HIW A,

AL PATI g 18 4
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3.7.7.

A 3-55. RiC4mE O

5 RN AT TAFRTSS UR IMFCITD WARRANTITS; IWCLODITG DU RoT TI T - | 5 =
26 WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPY Enter location here "| AR i
27 IN NO ENT SH. THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABL & main:
28 OR CONSEQUENTIAL DAMA » 0Bee02a2: addi sp,sp,-16
29 GOODS OR SERVICES; LO! @Eeee2ad: 1i ad, e
5@ ; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY TH BEBAE236: W ra,12(sp)
21 WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING MEGLI @EREE223: jal ex8eee382 <gd_eval led_init>
32 ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADV. se gd_eval led init(LED2);
33 OF SUCH DAMAGE. @5ee82aa: 1i ad,l
34 */ A8eee2ac jal exseee382 <gd_eval_led_init»
=5 51 gd_eval_led_init(LED3);
Z6 #include "gd32vfles.h" @8e282ac : 1i ag,2
57 #include "gd32vfle3v_eval.h" aseee2be: jal exseea3e2 <gd_eval_led_initr
558 #include "systick.h" 52 gd_eval_led_init(LED4);
59 #include <stdio.h» B580682b2: 1i al@,3
a @82282b4 jal 0x3000382 <gd_eval led_init»
Ja1e /! 56 gd_eval_led_on(LED1);
|42 main functiecn B88882b6 : 1i ae,o
|25 n[in] none B8ee82b3 jal Bx300834a <gd_eval_led_on>
|44 n[eut] none 57 gd_eval_led off(LED4);
|45 etval none = ©8eeazba: 1i a@,3
lag */ B eseeszbc: jal axseed3ta <gd_eval_led_off»
|27= int main(void) 58 delay_lms(l@ea);
s { B  eseeezbe: 1i a8, 1888
|29 gd eval led init(LED1); o 88eee2cl: jal 8x80008842 <delay 1lms>
a gd_eval_led_init(LED2); 2608 gd_eval_led_on(LED2);
51 gd_eval_led_init(LER3); E esese2c4: 1i ae,1
52 gd_eval_led_init{LED4);| = ©@BB882ce: jal 8x300034a <gd_eval_led_on>
53 = sl gd_eval_led off(LED1);
54 while(1){ @8@@02c8:  1i a8,
55 /* turp on ledl, turn off Jeda */ hd ARAARI 3 - dal od eval led off
iB i Debug 3
“ fBr S YR “ ”» > =g
Jo Rl bR, R CICH+”, RIMTHEAN AR
S N
3-56. i& i Debug ML
[E =clipse-workspace - Project RISCV/Application/mainc - Eclipse IDE — O x
le Edit Source Refactor Navigate Search Project Run Window
il | & =0 % -0- Q- ®™po - 48 ten|lBEalss B -F -0 Q |
| Project Explorer 2 = 8 4§ Debug ‘=' O =Varia.. % Brea.. &7 Expr.. B Mod.. Disas.. 2 2, Perip.. [}
EG5T E e R A PARTICOAR PURP ™ Enter location here ol & @SBl s
&5 Project RISCV (in Eclipse_proj A 27 & main: ~
& Includes 28 » 080002a2: | addi  5p,sp,-16 i
o 29 08080204: i a8, 8
v o Application 30 03EBA2a6:  sw ra,12(sp)
% main.c 31 ER 080002a8:  jal x3000302 <gd_eval led init
b ot 32 ARTSING IN ANY , EVEN IF ADV. E) gd_eval_led_init(LED2);
33 OF SUCH DA esepo2aa: i a8,1
~ = Debug 32 =/ psep@zac:  jal @x3800302 <gd_eval led init>
(= Application 35 51 gd_eval_led_init(LED3);
: 36 #include "gd32vf1es.h” 0g00e2ae:  li a0,2
& Peripherals 57 sinclude "gd32vF1e3v_eval.h” e8eeabe:  jal @x8000362 <gd_eval_led_init>
& RIsCV 38 #include "systick.h” 52 gd_eval_led_init(LED4);
(= Utilities 39 #include <stdio.h> 080002b2: i a8,3
20 080002b4:  jal 0x8600302 <gd_eval led init> E
L& makefile 410 /%1 6 gd_eval_led on(LED1);
L& objectsmk 2 main function esepezbs:  1i a0,0
[ sources.mk 43 none esepa2bs:  jal ox8pe034a <gd_eval led on>
a4 none 57 gd_eval led off(LEDA);
~ [ Doc .
- 45 none = eseeozba: i 0,3
5 readme.bt a6 %/ 8 eseeozbc:  jal @x806036a <gd_sval_led_off>
v (&, Peripherals E.ar— int main(void) _ 58 delay_lms(1008);
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4. FARELE

i TREAL, HnT B85 N O Eclipse T.f2 . fEEH 42, 55 i File->Import, & %
General->Exisiting Projects into Workspace & A\ &\ L%, ridi“Next’.

B 4-1. FAIA TR
= Import E@ﬂ

Select
. . . H
Create new projects from an archive file or directory. H

Select an import wizard:

pe filter text s

IJ = General I

Archive File
|.l . Existing Projects into Workspace

[ File System

] Preferences

»

m

[} Projects from Folder or Archive
| s = CfC+4+

s = Git

s = Install m
> = OComph
= RPM

» = Run/Debug

T [

3 _ — -
@ = Back MNext = Finish

L

P COH LR 4%, Eclipsesx R A HiZ 2 T IFTA LI, EEMENE TR, A&
“Finish”, BIa] S NBA L.
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A 4-2. FANBAEITHE-2

= Import O *
Import Projects i
Select a directory to search for existing Eclipse projects. / A.-'
[OREE R R RN M :\eclipse-workspace\GD32VF103 Firmware Library V1.1.2\Template| Browse...
() Select archive file: Browse...
Projects:
Project RISCV (Ei\eclipse-workspace\GD32VF103_Firmware _Library V1.1.2\Template\Eclipse_project) I Select All
Deselect All
Options
[I5earch for nested projects
[JCopy projects into workspace
[JClose newly imported projects upon completion
[JHide projects that already exist in the workspace
Working sets
[JAdd project to working sets New...
Select...
= Back Next = Cancel
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5. £ RAM iR

SR B E R LR (i Secleanbuild) , #lifEsin &b-1. FRAM#
WA d X Amemory map.

& 5-1. 7& RAM FiEi&H I1d 304 memory map

S MEMORY

64

7 £* Run in FLASH */

B/*

9 flash (rxailw) : ORIGIN = exB3@eeess, LENGTH = 128k
1@ ram (wxal!ri) : ORIGIN = @x280808088, LENGTH = 32K
e

12 f* Run in RAM */

13 flash (rxail!w) : ORIGIN = 82888028808, LENGTH = 24k
14 ram (wxalri) : ORIGIN = @x2088658088, LENGTH = BK
5

16 }

»bU%2: TEDebug Configurations->StartupiZ T, “ZJiERAM application.

A 5-2. 7£ RAM H A K Debug Configurations

= Debug Configurations m} X

Create, manage, and run configurations

i [F ¢ 2 X | B Y - Name: |Projer:t_RISCV Debug (1) |
|type filter text | [E Main 3&‘ Debugger | B Startup T‘é,' Source | [C] Common %‘_ SVD Path
[E] C¢/C++ Application [ [ A

[T] C/C++ Attach to Application
[E] C¢/C++ Container Launcher
[T] C/C++ Postmortem Debugg
[T] C/C++ Remote Application
Cif C/C++ Unit O Use file: Workspace... File System...

@ GDB General Debugging Sl G s l:l
[t] GDB Hardware Debugging
v [C] GDB OpenOCD Debugging legil srenEe
Project RISCV Debug (®) Use project binary:  eclipse-workspace\GD32VF103_Firmware_Library V1.1.2\Template\Eclipse_project\Deb
[C] GDB PyOCD Debugging O Use file: Workspace... | File System...
[t] GDB QEMU Debugging
v [£] GDB SEGGER J-Link Debugg Brecutable offset hex:[ |
Project_RISCV Debug (1)
& Launch Group

Load Symbols and Executable
Load symbols
(®) Use project binary: eclipse-workspace\GD32VF103_Firmware Library V1.1.2\Template\Eclipse_project\Deb

Runtime Options
RAM application (reload after each reset/restart)

Run/Restart Commands

Pre-run/Restart reset Type: l:l (always executed at Restart)

< >

Revert Appl
Filter matched 15 of 15 items Svel PPY

HIE3: B ARAMAERE I Debugtt K, 1 FIE.
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& 5-3. £ RAM F &K Debug AL &

| Debug [c ] main() at ma... BC| main.c & = O ®=Varia.. % Brea.. °F Expr.. B\ Modu... Disas.. ]
sl - Enter location here v|| &1
2 .
6 #include “gd3zvfles.h” ¢ main:
7 #include “gd32vflesv_eval.h” » 20000222 | E V= T PRt
5 #include "systick.h" 20600224 11 a2,@
9 #include <stdic.h> 20000206 | sw ra,12(sp)
Lo 200802a8: jal @x20008302 <gd_eval_led_init>
Lo 5@ gd eval led init(LED2);
lo main function 200002aa:  1i a0, 1
b= [in] none 2@@e82ac: jal ox20000302 <gd eval led init:
ba [out] none 51 gd_eval led_init(LED3);
b5 none 286008236 : 1i as, 2
be = 2886082b6 : jal 0x20008302 <gd_eval_led_init>
|75 int main(void) 52 gd_eval led_init(LED4);
Iz 1 29998222: lil a@,3 ’ 1 led
b E— . 26e602b4: ja ex20000302 <gd_eval led_init»
P :S;:::i;i:ﬂj:ﬁ Eﬁi B se _ gd_eval_led on(LED1);
1 gd_eval led_init(LEDR3); =] 2008802b6: ];1 ae,@
2 gd_eval led init(LED4); 0 208002b8: jal Bx20080834a <gd_eval_led_on:
3 - - 57 gd_eval led_off(LED4);
N while(1){ B 2eeeezba: 1i a8, 3
5 /* turn on ledl, turn off ledd */ BH 288882bc: jal 0x2000836a <gd_eval_led_off>
5 gd_eval led on(LEDL); ’ 58 ) delay_1ms(1888);
7 ed eval Ted offilFN4Y: N 260002be: 1i a@, lees
£ >
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6. fEF printf TED

6.1. ERASE

IRL: U _write BRI EUE o
ssize_t _write(int fd, const void* ptr, size_t len) {
const uint8_t * current = (const uint8_t *) ptr;

{
for (size_tjj = 0; jj < len; jj++) {
_put_char(currentjj]);
if (current[jj] =="\n") {
_put_char(\r);
}
}
return len;
}

return _stub(EBADF);

}

WUR2: Frusart® E [7) B put_char & i .
int _put_char(int ch)

{
usart_data_transmit(USARTO, (uint8_t) ch);
while (usart_flag_get(USARTO, USART_FLAG_TBE)== RESET){
}
return ch;
}

WUR3: T printfegi £, BT IERHTED . 3 & printf o 75 220 _E\nH SRRl i -

printf("Running led test!\r\n");

6.2. ITENE S BHERCE

FTENZ S BRRL S . 7F TFEProperties->C/C++ Build->Settings->Tool Settings->GNU RISC-V
Cross C Linker->Miscellaneous /4] i-u _prinft_floatiZ i .
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& 6-1. ITENFE AW E

(I

Resource

Build Vanables

Environment

Logging

Tool Chain Edito
C/C++ General
Linux Tools Path
MCU
Project Natures
Project References
Run/Debug Setting
Task Repository
Task Tags
Validation
WikiText

S Properties for Project RISCV

Settings

& Tool Settings & Toolchains M Devices

[ Container Settings # Build Steps E !

(2 Target Processor
(2 Optimization
(# Warnings
(£ Debugging
w B GNU RISC-V Cross Assembler
(22 Preprocessor
(2 Includes
(2 Warnings
(# Miscellaneous
w B GNU RISC-V Cross C Compiler
(22 Preprocessor
(2 Includes
(Z Optimization
(2 Warnings
A
~ B GMNU RISC-V Cross C Linker

@ General
(2 Libraries

Miscellaneous

(2 General

v % GNU RISC-V Cross Create Listing
(2 General

v [ GNU RISC-V Cross Print Size
(2 General

Linker flags (-Xlinker [option]) &

Other objects &

Generate map "${BuildArtifactFileBaseName

[ cross reference (-Xlinker --cref)
[JPrint link map (-Xlinker --print-map)

Use newlib-nano (--specs=nano.specs)

Use float with nano printf (-u _printf_float) l

[JUse float with nano scanf (-u _scanf float)
Do not use syscalls (--specs=nosys.specs)
Overbose (v

Other linker flags |

Apply and Close

Cancel

ERE:

145 F printfis] 7 ZLAEFT NG 0 A I A B IMAn, 1l Wprintf("Running led test!\r\n"). 2.

TEGCCHE A printf K K IARIL Fsize, 12X codesized K/NESRIR S &, AHERE

fii Fil printf
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7. & NyiLd
RT11. AL
R A5 iR H3#

1.0

il

202246 H20 H
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Important Notice

This document is the property of GigaDevice Semiconductor Inc. and its subsidiaries (the "Company"). This document, including any
product of the Company described in this document (the “Product”), is owned by the Company under the intellectual property laws and
treaties of the People’s Republic of China and other jurisdictions worldwide. The Company reserves all rights under such laws and
treaties and does not grant any license under its patents, copyrights, trademarks, or other intellectual property rights. The names and

brands of third party referred thereto (if any) are the property of their respective owner and referred to for identification purposes only.

The Company makes no warranty of any kind, express or implied, with regard to this document or any Product, including, but not
limited to, the implied warranties of merchantability and fitness for a particular purpose. The Company does not assume any liability
arising out of the application or use of any Product described in this document. Any information provided in this document is provided
only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality
and safety of any application made of this information and any resulting product. Except for customized products which has been
expressly identified in the applicable agreement, the Products are designed, developed, and/or manufactured for ordinary business,
industrial, personal, and/or household applications only. The Products are not designed, intended, or authorized for use as components
in systems designed or intended for the operation of weapons, weapons systems, nuclear installations, atomic energy control
instruments, combustion control instruments, airplane or spaceship instruments, transportation instruments, traffic signal instruments,
life-support devices or systems, other medical devices or systems (including resuscitation equipment and surgical implants), pollution
control or hazardous substances management, or other uses where the failure of the device or Product could cause personal injury,
death, property or environmental damage ("Unintended Uses"). Customers shall take any and all actions to ensure using and selling
the Products in accordance with the applicable laws and regulations. The Company is not liable, in whole or in part, and customers
shall and hereby do release the Company as well as it's suppliers and/or distributors from any claim, damage, or other liability arising
from or related to all Unintended Uses of the Products. Customers shall indemnify and hold the Company as well as it's suppliers
and/or distributors hRISC-Vless from and against all claims, costs, damages, and other liabilities, including claims for personal injury

or death, arising from or related to any Unintended Uses of the Products.

Information in this document is provided solely in connection with the Products. The Company reserves the right to make changes,

corrections, modifications or improvements to this document and Products and services described herein at any time, without notice.

© 2022 GigaDevice — All rights reserved
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